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INTRODUCTION

INTRODUCTION

DBArtisan is an industry-leading database administration solution for managing Oracle,
Microsoft SQL Server, Sybase Adaptive Server, Teradata, IBM DB2 for Windows, Unix, and Linux,
IBM DB2 for z/OS databases, and MySQL. Its cross-platform capability allows users to efficiently
manage heterogeneous database platforms easily using a single front-end tool. Using
DBArtisan, users boost their productivity by using a single tool for all their databases, regardless
of vendor.

ABOUT DBARTISAN

DBArtisan provides tools that can be used by a number of functions within an organization using
DBMS from multiple vendors, in testing, development, or production environments.

MAJOR FUNCTIONAL AREAS

Datasource management tools - Before use with DBArtisan, datasources must be registered.
Datasources can be registered manually or semi-automatically. Storage can be registry-based or
file-based, and a network storage option facilitates shared use of datasource catalogs.

Object management tools - DBArtisan supports a wide range of database objects and related
elements for each DBMS. You can create new objects, edit existing objects, and use a range of
object operations that support common, general or DBMS-specific actions.

Scripting environments - DBArtisan offers fully-featured environments dedicated to SQL, DDL,
Java and Active Script development. Execution options are available as appropriate, and
environment-specific related features, such as rollback/commit and query plan options, are
provided. Related coding aids include on-the-fly semantic and syntactic validation, text
substitution shortcuts, and visual query building tools. Related execution tools include script and
file execution facilities.

Schema and data utilities - Schema extraction, migration, and publication wizards let you
quickly extract and move schema and data across environments and even across DBMS types.
DBMS-specific import/export, load/unload, and backup/restore utilities are also available. A
Data Editor lets you edit your tables in real-time, supports all editable datatypes, and provides
Unicode options. Table data can also be imported from formats such as spreadsheets.

Other Time-savers and Productivity Tools - Working within the DBArtisan environment, you
have access to database and file search facilities, use visual difference to compare files or
database objects, and access the Microsoft Windows task scheduler.

License-specific Add-ons - Depending on the licenses you purchased, you have access to the
following tools:

® The Analyst Series includes advanced space, capacity, performance and backup
management capabilities. They let you predict and prevent storage-related problems, trend
data and object growth over time, and pinpoint performance bottlenecks.

DBARTISAN 9.6/XE5 QUICK START GUIDE 4



INTRODUCTION

® Debuggers, available for IBM DB2 for Linux, Unix, and Windows, Oracle, Sybase, and SL
Server, let you test functions and procedures. A Profiler is available for Oracle datasources.

BENEFITS TO SPECIFIC USERS
DBArtisan provides benefits to the following users:

Database Administrators

Developers

ABOUT THIS BOOK

DBArtisan lets database administrators accomplish more with the limited time they
have. It eliminates the tedious tasks associated with researching schema
dependencies when making object changes. Also included are a host of utilities,
which condense DBA tasks taking hours or days down to minutes.

DBArtisan provides an easy-to-use graphical user interface (GUI), which allows
Database Developers to be immediately productive in a cross-platform environment
without having platform specific knowledge. The GUI in general, and wizards and
editors specifically, provide time-savings over traditional hand-coding or other
manual methods.

In addition to a fully-featured scripting environment, DBArtisan offers several
cross-platform code-generation options, which help Developers build SQL code
that is syntactically and functionally correct the first time.

Complementing coding facilities, the object creation wizards and graphical object
editors greatly reduce the time and effort to build an application database from the
ground up.

DBArtisan facilitates moving applications and complete database systems between
environments.

This book has two major components:

e Installing DBArtisan lists technical requirements, provides details on DBMS version support,

summarizes the installation process, and includes licensing details.

e Tutorial exercises provides learning curve material on DBArtisan. It walks you through the
major areas of functionality, getting you ready for independent work.
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INSTALLING DBARTISAN

INSTALLING DBARTISAN

Before you can register any Embarcadero Technologies application, you must meet the
minimum technical requirements. If you meet all the minimum technical requirements, you can
install DBArtisan. After installation, you must license the application.

The following topics walk you through this process:

e Technical Requirements

e Database Support and Connectivity Options

¢ |nstalling DBArtisan

e |icensing DBArtisan

Lastly, for more information, see "Additional Product Resources" on page 16.

TECHNICAL REQUIREMENTS

Before using DBArtisan, please verify that your environment meets the following requirements:
® Microsoft Internet Explorer 7 or later

® Hardware Requirements

® Operating System Requirements

NOTE: Users need full registry privileges during the installation and access to the keys under
HKEY_CURRENT_USER in the registry after installation.

HARDWARE REQUIREMENTS
Embarcadero Technologies recommends the following minimum hardware requirements:

e Pentium 4-level processor
¢ 1 GB of memory

* 1 GB of disk space

e 1024 x 768 display

OPERATING SYSTEM REQUIREMENTS
DBArtisan supports the following operating systems:

* \Windows XP SP2 (32-bit and 64-bit)
¢ Windows Vista (32-bit and 64-bit)
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¢ Windows 7 (32-bit and 64-bit)
* Windows 8 (32-bit and 64-bit)
For more detailed information, see the following topics:

e XP Support

e Vista and Windows 7 Support

e 32-bit Versus 64-bit Operating System Support and Restrictions

XP SUPPORT
Windows XP has two user security groups:

e Users
e Power Users

Microsoft intentionally does not grant members of the Users Group the authority to install
applications or make global changes to the system. Restricted Users are members of the Users
Group. Standard users belong to the Power Users Group. Microsoft grants members of the
Power Users Group the authority to install programs. You must be a member of the
Administrators Group in order to install and use Embarcadero Technologies applications.

Because Restricted Users are members of the Users Group, they cannot install and run
Embarcadero Technologies applications.

CAUTION: You must be a member of the Administrators Group in order to install and use
Embarcadero Technologies applications.
To open the Group Membership tab where you can determine your group and review the
Microsoft security guidelines:
1 On the Control Panel, open User Accounts.

2 On the Users tab, select a user and then click the Properties button.

3 Click the Group Membership tab.

VISTA AND WINDOWS 7 SUPPORT
Windows Vista UAC and Windows 7 provide two user types:

e Standard user
e Administrator

DBArtisan can be installed or uninstalled by an administrator or by a standard user using an
administrator token. Standard users can run DBArtisan.
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CAUTION: For the purpose of running DBArtisan, default standard user token privileges
should not be modified. Modifying standard user token privileges can result in
licensing issues which will prevent DBArtisan from operating properly.

32-BIT VERSUS 64-BIT OPERATING SYSTEM SUPPORT AND RESTRICTIONS
If you install the 64-bit version of DBArtisan and you are using custom drivers, you must be using
64-bit versions of those drivers when using the 64-bit version of DBArtisan. Similarly, 32-bit
versions of custom drivers must be used with the 32-bit DBArtisan installation.

DATABASE SUPPORT AND CONNECTIVITY OPTIONS
DBArtisan provides dedicated DBMS platform support with the following connectivity options:

e For use with IBM DB2, SQL Server, MySQL, Oracle, and Sybase ASE datasources, DBArtisan
is packaged with a set of proprietary drivers that work in conjunction with a supported set of

clients that must be installed.

For information on the DBMS clients that must be installed, see "Packaged Embarcadero

Drivers with Native Client Support" on page 9.

e Alternatively, you can connect to a supported DBMS using a Type 4 JDBC driver packaged
with DBArtisan. For a listing of the third-party JDBC drivers, see "Third-party JOBC drivers"

on page 9.

The following table lists the DBMS platform versions for which dedicated support is provided,

and the connectivity options supported:

DBMS Version Native Driver Packaged

Support Third-party JDBC
Client Support

IBM DB2 for z/OS 8, 9, and 10 v v

IBM DB2 LUW 9.0 - 10.0 v

Microsoft SQL Server 2005, 2008, and 2012 v v

For SQL Server 2005 and 2008, only object types like users, logins,

roles, config parameters, etc., are supported. We do NOT support

Microsoft .NET extensions at this time.

MySQL 4.x. v v

(DBArtisan is tolerant of 5.x but does not support Stored Procedures,

Triggers, or Views)

Oracle 9i, 10g, 11g, and 12¢ v 4

Sybase ASE 12.5-15.7 v v

Sybase 1Q 12.7 - 15.4 v v

Lastly, generic JDBC and ODBC is provided for non-dedicated DBMS platforms and other
datasources. For details, see "Generic JDBC and ODBC Support" on page 10.

DBARTISAN 9.6/XE5 QUICK START GUIDE




INSTALLING DBARTISAN

PACKAGED EMBARCADERO DRIVERS WITH NATIVE CLIENT SUPPORT

If you are using the prepackaged Embarcadero drivers to connect to supported DBMS
platforms, ensure that the relevant clients are installed and configured:

DBMS Client

IBM DB2 for z/OS DB2 UDB Client for Windows 9 or later

IBM DB2 for Linux, Unix, | IBM DB2 LUW Client for Windows 9 or later

and Windows

Microsoft SQL Server Microsoft SQL Server Client Library

MySQL MySQL Connector/ODBC Driver 5.2.x Driver - MySQL Connector/ODBC driver 3.51.x
Driver

Oracle Oracle SQL*Net Client

Note: If the Oracle SQL*Net Client is not installed, DBArtisan will attempt to connect
using the Oracle Database Instant Client.

Sybase ASE Sybase Open Client

Sybase 1Q SQL Anywhere ODBC drivers for Sybase 1Q 12.7
Sybase 1Q 32-bit ODBC drivers

Teradata Teradata ODBC driver for Windows (version 14 recommended)

THIRD-PARTY JDBC DRIVERS

If policy or preference dictates use of Type 4 JDBC drivers, the following table includes the
drivers supplied for each supported DBMS platform:

Platform JDBC Driver

IBM DB2 for Linux, Unix and Windows IBM Data Server Driver for JDBC

IBM DB2 for z/OS

Microsoft SQL Server jTDS Type 4 JDBC Driver for Microsoft SQL Server
Microsoft SQL Server JDBC Driver

MySQL MySQL Connector/J JDBC Driver

Oracle Oracle JDBC Thin Driver

Sybase ASE jTDS Type 4 JDBC Driver for Microsoft SQL Server
Sybase jConnect JDBC Driver

Sybase 1Q Sybase jConnect JDBC Driver for Sybase 1Q

Teradata Teradata JDBC Driver

EMBARCADERO CONNECT SUPPORT

DBArtisan can make use of datasource definitions stored on an Embarcadero Connect server.
For details, see "Working With Datasources from a Connect Repository" on page 138.
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GENERIC JDBC aAND ODBC SUPPORT

Generic JDBC/ODBC connectivity to non-dedicated DBMS systems or non-database
datasources is also provided. DBArtisan can connect to a datasource using a customer-provided,
third-party JDBC version 3.0 or ODBC version 3.0 driver. Minimal DBArtisan functionality is
provided, including a basic Explorer tree and SQL querying.

IBM DB2 FOR Z/OS STORED PROCEDURE REQUIREMENTS

When working against an IBM DB2 for z/OS data source, DBArtisan relies on the following
stored procedures, provided as an optional installation step in setting up the DB2 subsystem:

+ DSNWZP
+ DSNUTILS

+ ADMIN_ COMMAND DSN
+ ADMIN_ COMMAND DB2

Prior to using DBArtisan against an IBM DB2 for z/OS data source, ensure that these
components are installed on the server. See IBM DB2 for z/OS documentation for more
information.

INSTALLING DBARTISAN

To install DBArtisan successfully, you must complete each panel of the installation wizard. 64-bit
and 32-bit versions of DBArtisan are available with the trial version, which can be downloaded
from http://www.embarcadero.com/products.

The DBArtisan installation wizard installs all corresponding files on your machine. The installer
offers common options such as license agreement, file and folder selections, and shortcut
options. An application-specific option lets you associate file suffixes of elements such as SQL
scripts with DBArtisan.

NOTE: Before installing DBArtisan from Embarcadero ToolCloud, see http://
docs.embarcadero.com/products/xe/ for additional requirements or revised
instructions.

The panels presented by the wizard vary depending on whether you are upgrading or
performing an initial installation.

CAUTION: If you have not registered a license when you start a DBArtisan installation, you
will be prompted to register a license. For more information, see "Licensing
DBArtisan" on page 11.

After the installation is complete, we recommend that you reboot your machine before using
DBArtisan.
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LICENSING DBARTISAN

Each Embarcadero client application requires one or more licenses in order to run. An
Embarcadero product, such as DBArtisan or ER/Studio, has a baseline license which provides
basic feature support for that product. In addition, incremental licenses may be required to
support specific DBMS platforms, product add-ons, or other functions.

For more information, see the following topics:

e | icensing Overview

e |icensing Your Application

e Selecting a License Category During Startup

e Online/Offline Mode and Concurrent License Checkout

LICENSING OVERVIEW

The following topics provide a high-level discussion of key licensing topics and directs you to
sources of more detailed information.

® Viewing Your License Type and Modules

Understanding Trial, Workstation, and Networked Licenses

DBArtisan License Modules, DBMS Support, and Feature Availability

DBArtisan XE License Modules, DBMS Support, and Feature Availability

e Directing Queries Regarding Licenses

VIEWING YOUR LICENSE TYPE AND MODULES

The About... dialog, available from the Help menu, displays your license type and each
individual license module currently registered.

UNDERSTANDING TRIAL, WORKSTATION, AND NETWORKED LICENSES
Three kinds of licenses are available: Trial, Workstation, and Networked.

Trial licenses A license for a 14-day, full-featured trial version of the product. The trial license must be
registered before you can use the product.

Workstation licensing A license or set of licenses is tied to a particular workstation. The product can only be
used on that workstation.
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Networked licensing Networked licenses are administered and distributed by a central License Server
(Embarcadero License Center or Acresso FLEXnet Publisher). There are two types of
networked licenses: Concurrent and Networked Named User. With Concurrent licensing,
users on different machines take turns using licenses from a shared pool. With
Networked Named User licensing, licenses are pre-assigned to specific users setup on
the license server's user list. Those users are guaranteed to have licenses available any
time.

NOTE: Concurrent licenses can be borrowed for use without a network connection. For
details, see "Online/Offline Mode and Concurrent License Checkout" on page 15.

For a detailed description of licensing options, see http://www.embarcadero.com/software-
licensing-solutions.

DBARTISAN LICENSE MODULES, DBMS SUPPORT, AND FEATURE AVAILABILITY

Individual license modules correspond to the DBMS platforms you are licensed to use. In
addition, each DBMS license module corresponds to a product edition. Feature availability for
each license module edition is as follows:

e Standard - Provides baseline support including datasource management, object
management, SQL editing and execution, and standard tools and utilities.

¢ Professional - Standard edition features plus SQL Debugger and SQL Profiler.

* Workbench - Professional edition features plus Performance Analyst, Space Analyst,
Capacity Analyst, and Backup Analyst.

DBARTISAN XE LICENSE MODULES, DBMS SUPPORT, AND FEATURE AVAILABILITY

An XE license provides access to all supported DBMS platforms. XE module and feature
availability is as follows:

e XE Pro - Provides baseline support including datasource management, object
management, SQL editing and execution, and standard tools and utilities, SQL Debugger
and SQL Profiler.

¢ Analyst Pack - Provides access to Performance Analyst, Space Analyst, Capacity Analyst,
and Backup Analyst.

DIRECTING QUERIES REGARDING LICENSES
Questions regarding license availability, feature availability, and client or server licensing, should
be directed as follows:

e If you work in an organization that uses networked licensing, direct any questions to your
site’s DBArtisan administrator.

e |f you are using workstation licensing, direct licensing questions to your Embarcadero
Technologies representative.
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LICENSING YOUR APPLICATION

See the following topics for details on registering your product:

e Registering a Trial or Workstation License during Installation

® Registering a Workstation License After Application Startup

e Registering By Phone

e Registering a Networked License

REGISTERING A TRIAL OR WORKSTATION LICENSE DURING INSTALLATION

Shortly after initiating download of a trial version of an Embarcadero product, you should receive
an email with a serial number you must register during installation. Similarly, if you purchase an
Embarcadero product while no trial version is active, you will receive a serial number that must
be registered during installation.

1 Start the installation. An Embarcadero License Registration dialog appears.
2 Copy the serial number from the email and paste it in the Serial Number field.

3 Enter your Embarcadero Developer Network account credentials in the Login or Email and
Password fields. If you have not previously created an EDN account, or have forgotten your
password, click | need to create ... or I've lost my password.

4 Click Register.

Your activation file should be downloaded and installed automatically. If this does not happen,
click the Trouble Connecting? Try Web Registration link and follow the prompts. If you still
have problems, see "Registering By Phone" on page 14.

REGISTERING A WORKSTATION LICENSE AFTER APPLICATION STARTUP

The following instructions assume that you have received a workstation license by email and that
you currently have a valid trial license. If you did not install a trial version or the trial period has
expired, follow the instructions in "Registering a Trial or Workstation License during Installation"
on page 13 instead.

1 On the Help menu, select About, and then on the dialog that opens, click Manage to open
a license manager dialog.

2 On the Serial menu, select Add.

3 Copy the serial number from the email and paste it in the Add Serial Number dialog, then
click OK.

4 Right-click on the serial number you added, and then select Register from the context
menu. A registration dialog opens.

NOTE: The Registration Code box shows a machine-specific identifier required with other
registration methods.
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5 Ensure that the Register using Online Registration radio box is selected.

6 Provide Developer Network credentials in the DN Login name or Email and DN Password
boxes. If you have not previously created an EDN account, or have forgotten your password,
click I need to create ... or I've lost my password.

7 Click Register.
8 If prompted to restart the application, click Yes.

Your activation file should be downloaded and installed automatically. If this does not happen,
click the Trouble Connecting? Try Web Registration link and follow the prompts. If you still
have problems, "Registering By Phone" on page 14.

REGISTERING BY PHONE
If you have problems with either of the above procedures, you can register licenses by phone.
You will have to provide:

¢ Developer Network credentials

e The registration code displayed in the Embarcadero License Registration dialog that
appears when you start an unlicensed application

The product base license serial number

The license serial numbers for any additional features you have purchased.

For North America, Latin America and Asia Pacific, call (415) 834-3131 option 2 and then follow
the prompts. The hours are Monday to Friday, 6:00 A.M. to 6:00 P.M. Pacific time.

For Europe, Africa and the Middle East, call +44 (0)1628-684 494. The hours are Monday to
Friday, 9 A.M. to 5:30 PM. U.K. time.

Shortly after phoning in, you will receive an email containing an activation file. Then do the
following:

1 Save the file to the desktop or a scratch directory such as c: \temp.

2 On the Help menu select About and then on the dialog that opens, click Register. A
registration dialog opens.

3 Select the | have received an activation file (*.slip or reg*.txt) radio box.

4 Click the Browse button and use the Select License Activation File dialog to locate and
select the activation file you installed.

5 Click the Import button to import the activation file and when complete, click the Finish
button.

6 If prompted to restart the application, click Yes.
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REGISTERING A NETWORKED LICENSE

If you work in an organization using Networked licensing, an administrator, department head, or
someone performing a similar function will provide you with an activation file.

Once you receive the file, save it to the 1icense subfolder of your product’s main installation
folder (typically C:\Program Files\Embarcadero\<product><version>\1license\), then restart
the application.

No additional steps are necessary.

SELECTING A LICENSE CATEGORY DURING STARTUP

During DBArtisan startup, if multiple concurrent license categories are available, you are
prompted to select a category to use for this DBArtisan session. Multiple license categories can
be set up to provide differing feature access or access to different DBMS versions. Feature and
DBMS version access are typically distributed across multiple license categories to optimize use
of a sites purchased licenses.

NOTE: This dialog also includes the option to remember your selection on subsequent
startups. If you select that option, you can subsequently use the Select Licenses button
on the About... dialog (Help > About) to select a different license.

Contact your License Administrator for details on individual license categories or requests for
additional feature or DBMS support.

ONLINE/OFFLINE MODE AND CONCURRENT LICENSE CHECKOUT

Concurrent licenses can be used in both online and offline modes. In online mode, you must
have a continuous network connection to your License Center. Licenses are checked out when
you start DBArtisan and checked back in when you shut DBArtisan down.

You can also use a license in offline mode. When you explicitly check out a license for offline use,
you can use DBArtisan without a connection to your License Center for a specified duration. This
lets you work while travelling or commuting, work away from your primary work area, or use
DBArtisan when a network connection is unavailable or not required.

NOTE: Contact your site administrator for information on offline license availability, the
maximum duration, offline license policy at your site, or any other issues arising from
online license usage.

To check out a license for offline use:

1 On the Help menu, select Checkout License. The Check Out Licenses For Offline Use
dialog opens.

2 Select the check box associated with each individual license you want to check out.

3 Inthe Checkout Duration box, type the number of hours that you can use the offline license
without a network connection to the License Center.
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4 Click OK.
You can work offline for the specified duration. The duration period begins immediately.

If you subsequently establish a network connection to the License Center before the license
duration expires, you can indicate to the License Center that the offline license is no longer
required.

To indicate that an offline license is no longer required:

1 On the Help menu, select Checkin License.

There is no interruption in DBArtisan usage. The license is not actually checked in until you shut
down DBAtrtisan.

ADDITIONAL PRODUCT RESOURCES

The Embarcadero Web site is an excellent source for product information and access to
additional resources:

® Release notes and product documentation

Information on other Embarcadero application and database development tools

Embarcadero Development Network

Product and technical support

Educational and product expertise material in the form of online demos, white papers, and
video presentations

o Access to sales staff and Embarcadero resellers

For access, direct your browser to www.embarcadero.com.
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TUTORIAL EXERCISES

The exercises that follow walk you through DBArtisan’s major functional areas. After completing
these exercises, you will have the foundation you need to explore the many features and
benefits of DBArtisan. You'll have learned how to competently manage the major database
administration disciplines using DBArtisan’s standard cross-platform console. In addition, you
will have a solid understanding of DBArtisan’s more advanced Space, Performance, and Capacity
management capabilities.

This guide is divided into 10 sessions:

e Session 1: Getting Started with DBArtisan

e Session 2: Object and Schema Management

e Session 3: Database Security Management

e Session 4: Space Management

e Session 5: SOL Management

e Session 6: Job Management

e Session 7: Data Management

e Session 8: Performance Management

e Session 9: Capacity Management

e Session 10: General Utilities and Tools

You can use this basic tutorial as a roadmap of product highlights, but also to help you find your
own path to explore DBArtisan.

Once you've started, you can select Help Topics from the Help menu to find many additional
resources that complement and build on many of the activities shown in this tutorial.

SESSION 1: GETTING STARTED WITH DBARTISAN

How you start DBArtisan depends on the type of application you are evaluating:
¢ InstantOn version — start the application by double-clicking the file you downloaded.

e Fully-installed version — The Start menu sequence for DBArtisan is always in the form
Programs > Embarcadero DBArtisan version identifier > Embarcadero DBArtisan version
identifier, where version identifier reflects the version you are running.

DBARTISAN 9.6/XE5 QUICK START GUIDE 17



TUTORIAL EXERCISES

To get started
1 Run DBArtisan.

The first time DBArtisan starts, a dialog opens, prompting you to set up datasources. In
addition to letting you manually set up individual datasources, a number of more
automated methods are available. If you have installed and used other Embarcadero tools,
DBArtisan can find any active datasources being used by those tools. In addition, DBArtisan
provides a Discover Datasources feature that automatically searches the DBMS
configuration files on your system for datasources that are not currently registered. Since
other Embarcadero tools let you export datasource definitions to file, you also have the
option of importing these definitions.

2 For the purpose of this tutorial, click Cancel. You will be registering a datasource manually.

REGISTERING CROSS-PLATFORM DATASOURCES
The Datasource Registration Wizard walks you through the process of registering a datasource
for use with DBArtisan.

1 On the Datasource menu, select Register Datasource. DBArtisan opens the wizard, initially
prompting you for the DBMS type.

2 Select Oracle as the database type and then click Next. DBArtisan opens the next panel of
the Datasource Registration Wizard.

Fegister Datasource | E2 |

Information =
Pleaze enter the connection information for the Oracle server. You cah either select an entry [.[’
from vaur THSMames. ora file, from an LDAP zerver or enter the information manually,

Database Type
Connection Information Regiztration bype: | User defined - |

Security Parameters

Custom Driver Properties | Hosp | |

Datazource Properties

Oracle Wiew Config Port: 1521

Datasource Group SID/Service Mame: | | Type: @) SERWICE_MAME () SID

|nztance Mame:;

Datasource Mame: | |

T ezt Connection < Back T ewt > Finizh Cancel Help

3 Ensure that User defined is selected and provide the Host machine name associated with
an Oracle datasource.
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Type a Port number. The default is 1521, but you can change it to wherever the Oracle
listener is set up.

Specify a Type of SERVICE_NAME or SID and enter the corresponding value in the SID/
Service box.

In the Datasource Name text box, type SAMPLE_DATASOURCE for the purpose of this
example.

Click Next. DBArtisan saves your selections and opens the next panel of the wizard. This is
where you enter login credentials.

Provide a User ID and Password.

To save and encrypt your password so that you do not have to provide credentials each time
you connect, select Auto-Connect?.

Click Datasource Group to display the last panel.

In the Managed Datasources tree, select the folder corresponding to the type of DBMS you
are registering.

Click Finish. DBArtisan prompts you as to whether you want to connect to the datasource.

Click Yes.

The same easy-to-use Datasource Registration Wizard is available for directly-supported DBMS
platforms as well as JDBC and ODBC datasources. Datasource information is stored in the
registry, is editable, and datasources can be deleted. If you run multiple Embarcadero products
on the same machine, they can share the same datasource catalog.

A number of datasource catalog storage options are available:

* Alocal, file-based alternative lets you easily move a datasource catalog between users.

* A remote, file-based alternative lets multiple users share a single catalog. Settings can be

changed locally but are not propagated to other users or retained over shutdown/startup

Another way of centralizing datasource definition maintenance is available if you use
Embarcadero Connect. Datasource definitions can be stored on a Connect server, and
subsequently registered as local datasources. Local connection details for a datasource are
synchronized with the Connect server version on each attempt to connect to a datasource.

For details on datasource options, refer to the DBArtisan online Help.

SETTING UP THE DATASOURCE EXPLORER

The first time that you start DBArtisan, the Datasource Navigator occupies the left side of the
main window. It is a single pane window that lets you navigate the datasources that you register
and initiate actions against databases and database objects.
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Datazource Mavigator B ox
P& ¥
(51 DBZ Servers
01 Interbase-Firebird Servers
[C1 JDBC Servers
1 M5 S0L Servers
i) kA S0L Sercers
i My Custarm_Group
1 Oracle Servers

[ Servers
031 Sybase Servers

For the following set of exercises, you will be using a similar aid.

To prepare for subsequent exercises
1 Dismiss the Navigator by clicking the close button (X) at the top of the Navigator window.

2 Select View > Activate Explorer.

The Datasource Explorer is a two pane window that provides most of the same functions as the
Navigator.

ju) {} ROMLABORCL11g 2 - Storage
-3 M5 S0L Servers &
- [0 MySQL Servers Control Files
« [[3 My _Custorn_Group L Directories
4 [3) Oracle Servers 1 Reda Log Groups
4 8 ROMLABORCL11g_2 (Oracle 11.10.7.0 | | @yRollback Segments
- B Filters 1 [ Tablespaces
. Eh Instance
. |§F Storage
- &7 Security
. Ad Scherna
. B Performance
. Bl RO ARORCT 11 3 i0eacla 1120110 ™ | 5 Item(s) | |

One key difference is the right pane of the window. It displays details for the node currently
selected in the left pane. This might be individual database objects such as tables or primary
keys, configuration parameters, and so on.
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Before proceeding, familiarize yourself with the View menu commands for opening the
Navigator and Explorer, and the ways to close those windows. As you proceed with DBArtisan,
you will develop a preference for either the Navigator or Explorer, or find that each has benefits
that are preferable in different situations.

GENERAL USABILITY FEATURES

DBArtisan provides many “user in mind” features that make the product configurable to meet
individual needs and preferences. These features are designed to shave time off the tasks that
you perform many times on any given working day.

Retaining Datasource Explorer View Settings
1 At the top of the Explorer tree, click to expand the drop-down menu.

L ¥

. [T DE2 Servers Organize by Object Owner

[T Interbase-Firebird Servers Show System Objects ,
. [ JDBC Servers gl s st <

ow Only My Objects

- [ MS SOL Servers
» 23 MySQL Servers Full Refresh
- [ My_Custormn_Group
- [ Oracle Servers Expand All Groups
. [ Servers Collapse All Groups

: [E] Sybase Servers Collapse &ll Datasources

Retain View Setz\}ngs

EBookmarks k

2 Select Retain View Settings.

The next time you open DBArtisan, the Explorer appears just as you left it.
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Working with Datasource Explorer Bookmarks

1 Inthe Explorer tree, right-click the datasource you registered and select Add bookmark
from the context menu.

S| SAMPLE_DATASOURIE ((eoslatt 2n
| Canneck

Change Group. ..
Edit

TR

Unregister

I
B

M

Reqgister Like

Monitaor
Configure. ..

Extract

u
2

e

o

Migrate. ..

Carmmand »

Refresh
Filter ...
Copy object namels) Chrl+C

| Add bagkmark |
A |

DBArtisan opens the Add Friendly Bookmark Name dialog.
2 Click OK.

After Bookmarks are defined you can use them to easily navigate to commonly used datasource
resources using the dropdown at the top of the Explorer and selecting the Bookmarks item.

Bookmark, Manager. ..
Oracle l\é P| Datasource: SAMPLE_DATASOURCE
5 |

Setting Keyboard Shortcuts and Hotkeys

1 From the Tools menu, select Customize. The Customize dialog opens.

2 In the Customize dialog, open the Keyboard tab.
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The Keyboard tab can be used to set keyboard shortcut hot keys for all areas of DBArtisan

functionality.

3 Click Close.

Datasource Explorer tree filtering

DBArtisan provides a number of ways to filter the Datasource Explorer tree, easing navigation.
During a DBArtisan session, you can use the Filter box at the top of the Datasource Explorer to
display only those objects whose name contains characters typed in the Filter box.

i .
- h:l ME; SQL Servers
= ;ﬁ'-_‘]'ETORLP.BSQLDB_l (S0l Server 10.00.16
[+ B Filkers

I+ Eh Server
[+ Storage
[~ Security
#-r'}) Databases
B Performance
= [ oracle Servers
= ﬁ.;] TORLABCRCLI1g_Z (Dracle 11.1.0.6)
=g Schema
+ A CODRUTA
+- A COSTIM
+- A SCoTT
253 Svbase Servers
- ﬁi TORLABSY 1S5 2 (Svbase Adapkive Serw
=l-£}} Databases (45)
+-[] codruta
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If you are interested in a more permanent filtering method, you can create filters at the DBMS or
datasource level. Filters are available under the Filters node for each datasource.

[

05 1
Ei zﬂj‘"ﬁi:ili:rer; l{:}n]l '
----- |:| B Ignore Systemn Objects (0)
----- |:| B Show Only My Objects (00
----- V| B araclez (0
-- ¥| B Mew Filker {0}

[ |+ F Storade

Right-clicking in the tree and selecting Filter opens the Filters dialog. It lets you filter out object
types at the DBMS platform level. It also lets you create object filters.

Object filters can be object name-based, schema-based, or some combination thereof. A name-
based or schema-based filter consists of one or more ANDed conditions. You also specify the
object types to which the filter is to apply.

=

_5 5 Ohiject Filkers W E

=+t DB2

rl rﬂ DB2 205
=+ 2l T Ignore System Objects
E‘ [ 12" show Orly My Objects

| |
| |
v D7 MyFilter | Fename |
| |

Mew

Delete

EEHE

lTI fﬂ Oracle
=i M5 SaL
: ._'_' D?’ Ignore Sywskem Objecks

Clane

A

Wi .
; -1 shaw Orly My Objects :O By Datasourcs
- £ MysQL ; _
-t} Sybase {{#1 By Filter

Froperty | e Yalue

Name j : i

=
i
=

Delete

k. | | Canicel | | Help |
2|

Object filters are created at the DBMS or datasource level and can be enabled and disabled for
individual datasources.

The Filters dialog also lets you hide or display nodes based on object type. Node filtering lets
you filter out object types for all datasources of the same DBMS type.
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-l Cracle
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Control Files
Lg Directories
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[+ az' Security
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- [¥] B Performance
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+- T MySQL
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In addition to any custom object filters you create, the Filters node also provides access to two
default filters: Ignore System Objects and Show Only My Objects. They can be applied at the
datasource level and cannot be deleted or modified.

SESSION 2: OBJECT AND SCHEMA MANAGEMENT

DBArtisan provides unparalleled database object management capabilities. Its database
platform-specific and version-specific graphical object editors and wizards enable you to easily
create, drop or alter any of your accessible database objects.

CREATING A TABLE OBJECT

The following example walks you through creating a standard Oracle table object. This concept
carries across all of the supported object types, across all of the supported platforms.

1 On the Datasource Explorer, expand the Schema node of an Oracle datasource.
2 Right-click the Tables node, and then select Create.

3 DBArtisan opens the Table wizard and leads you through the process of creating a table
object.
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Create Table Wizard - Step 1 of 10

Properties
Specify the kable properties.,

Properties

Property Walle

= Creation

Schema b

M arne

= Table
Cache
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FParallel Degres
Farallel Inztances

i e
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Fow Organization HEAF -
Logging ]
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| Cancel || Help

4 Complete the wizard panels, and ensure that you create two or more columns in the table.
5 Click Finish.

DBArtisan lets you preview any and all generated scripts before you submit them to the
database. This is standard for all object-related scripts.

MAKING CHANGES TO AN EXISTING TABLE OBJECT

Changes to database tables, such as modifying column lengths, inserting new columns, or
deleting unneeded ones, can require dropping of a table. This requires knowledge of the
underlying object dependencies so that these dependent objects are rebuilt after the table has
been recreated. DBArtisan provides the ability to perform “extended” table alterations by
constructing a SQL script with the steps necessary to save off the original data, create the new
table, and populate it with the original data. Once these steps are complete, all dependent
objects are then rebuilt and permissions re-applied.

1 From the Explorer, Tables node, select the table you created in the previous example.
2 Double-click the table or from the Command menu, click Open.

DBArtisan opens the Table Editor. The Table Editor provides access to basic table
properties, the list of table columns as well as any constraints, storage parameters, space
allocation, partitioning, table dependencies, object privileges, table DDL and other
attributes of the table.
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3 Ensure that the Columns tab is selected and select one of the columns you created in this
table you want to modify.

Details for the column are shown in the Column Attributes area on the right side of the
pane.

4 In the Width or Scale text box, type a new value.
5 On the Table Editor toolbar, select the Alter button.
DBArtisan lets you preview the SQL script before you submit it to the database.

6 Close the Table Editor pane.

WORKING WITH OBJECT DDL

DBArtisan allows you to easily extract DDL for single or multiple objects using several methods.
The most straight-forward is described here:

1 On the Explorer, right-click the table you created earlier, and then select Extract.

The DDL for all highlighted objects is extracted directly in a DDL Editor where it can be
altered, executed and saved to the database, with no intermediary steps required. For
example:

@™ > MO KB R Al
CREATE TAELE ADINAF. AAAAAA =

=1
"a" NUMBER(6,0)  NULL
)

ORGANIZATION HEAP
TABLESPACE SYSTEM

NOLOGGING

PCTFREE 10

PCTUSED 40

10 INITRANS 1

11 MAXTRANS 255

12 STORAGE(BUFFER_POOL DEFAULT)
13 NOPARALLEL

14 NOCACHE

15 NOROWDEPENDENCIES
16 / <

m

=R N = I I R TR N

Auto Commit OFf | | \ROMLABORCL11g 2hsystem | Linel Coll | |

2 Close the PL/SQL Editor pane.
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SESSION 3: DATABASE SECURITY MANAGEMENT

DBArtisan can help you efficiently establish and maintain database security. Whether you are
managing an existing production database or setting up a new environment, you'll find
consistent support across all of the supported platforms.

ADDING A NEW DATABASE USER

While this example focuses on creating a new Oracle user, the same wizard-driven principle
applies to all security objects (groups, roles, etc).

1 On the Datasource Explorer, expand an Oracle datasource, and then the Security node.
2 On the Security node, right-click Users, and then click Create.

DBArtisan opens the Create User Wizard and leads you through the process of adding a
user.

o 51

Create User Wizard - Step 1 of 6 -

Properties
Specify user name,

Properties

Froperty Y alue

E Creation . ||
M arme |

H Defaults I
Default Tablezpace ISERS = |
Tempaorary Tablezpace TEMP -
Prafile DEFALILT -|

B Account '
| dentified By REQUIRED_YES i

Fazsword

Frish | [Cancal | [ Help ]

3 Provide the information on each panel of the Create User Wizard until you reach the DDL
View panel.

DBArtisan allows you to preview any and all generated scripts before they are submitted to
the database. This is standard for all object-related scripts.

4  Click Execute to create the new user.

DBArtisan automatically opens the User Editor for the new user. The standard User Editor can be
used to manage existing database users as shown below.
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GRANTING AND EDITING USER PRIVILEGES

Privileges can be easily granted, revoked, or viewed from within either of two editors within
DBArtisan; the User Editor, or the individual object editor (Table, Procedure, etc.). The User
Editor provides a tabbed interface, which can be used to view and modify individual attributes of
the user.

1 In the User Editor, open the Object Permissions tab.
2 Use the Object Type dropdown to select a set of objects such as tables or views.

3 Right-click a cell (corresponding to a specific object and a specific permission, such as
DELETE), and then click Grant.

A distinctive icon is shown in the cell, indicating that this permission is granted. You use a
similar process to revoke privileges and perform other permission-based activities.

4 On the Object Editor toolbar, click Alter to implement the changes.

SESSION 4: SPACE MANAGEMENT

Managing space is vital to ensuring the availability and performance of your databases.
DBArtisan incorporates many built-in space features that let you smartly manage and exploit all
aspects of your database’s storage. The following example walks you through a review of
DBArtisan’s built-in support for reporting Oracle tablespace storage and space data.

BUILT-IN SPACE MANAGEMENT

While this example is specific to Oracle tablespaces, the same concept applies to all of the
supported platforms.

1 On the Datasource Explorer, expand any Oracle datasource.
2 On the Oracle datasource, expand the Storage node, and then select Tablespaces.

3 Right-click any tablespace listed in the right pane of the Explorer window, and then click
Open.

Embarcadero DBArtisan opens the Tablespaces Editor.

4 Select the Properties tab. The Storage group on that tab provides a summary of the space
settings for the tablespace.
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5 Select the Extent Details tab. It provides more detail on an extent-by-extent basis.

e Extent details
| Twpe Mame File ID| Estent D Block D Blocks  Butes i_“‘*.i
IMNDEX SERGIU.UK_DATE 71 ] 79 A E5R36 [
TABLE SERGIU.TESTTABL. .. 71 ] 745 g EBE536
TABLE SERGIUJ.TESTEMCR... 71 ] Bl 2 BER36
TABLE SERGIUSTUDEMTS.. 71 ] 713 g  E5R36 =
TABLE SERGIUSTUDEMTS.. 71 ] 729 2 EB5R36 F
IMDEX, SERGIU.PE_DATE 71 ] 7h1 g  E5R36 I
INDE SERGIU.PEID_EAFK1 71 ] 737 2 ERLR3E il
| TABLE SERGIUJOBURI_EA. .. 71 ] 721 8  E5R36 |

6 On the Tablespace Editor, click the Space tab.

The Space tab displays a graphical view of the free and used blocks for the target
tablespace.
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Distribution of Tablespace Space

@ Free Blocks 83.3%
@ UsedBlocks  167%

7 Finally, on the Tablespace Editor, click the Map tab.

The Map tab displays a color-coded map of the objects contained on the tablespace. The
map segments are proportional to the actual size of the objects on the tablespace.
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Map ]
Space Info = : -
Totsh 20000ME  Fres:  162.88 ME | Heorserize || Legend.. || Display. |
Used 31.13ME % Free: 84.44 | FitInWindow | Ful Sereen |

- Object Demographics

Hame Extents Blocks

1 HR .M 1 g

2 COSTIM.SYS_LOBOOO0347492C00003%% 1 3

3 COSTIM.SYS_CO086136 21 7E3

4 COSTIM.SYS_CO0BE135 1 3
bl B COSTIR S%S 1 NONNA7AQ2CONNN2E 4 1 o i
<1 | [

Note the additional Reorganize and display options.

8 Close the Tablespaces Editor pane.

ADVANCED SPACE MANAGEMENT (ORACLE AND SQL SERVER ONLY)

For advanced space analysis and management, DBArtisan’s optional Space Analyst component
contains sophisticated diagnostics to help you pinpoint all space-related problems in your
database, as well as an intelligent reorganization wizard that can reorganize all or selected parts
of your database.
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NOTE: Space Analyst is a separately-licensed component. If you are not working with an
evaluation copy of DBArtisan or do not have a specific license, proceed to Session 5:
SQL Management. Contact your license administrator or your Embarcadero
representative about obtaining a license.

To see the sort of information provided by the Space Analyst
1 On the Analyst menu, select Space Analyst.

NOTE: If prompted to install components on the server, allow DBArtisan to install the
components.

The Space Analyst launches in the DBArtisan workspace.

Embarcadero’s Space Analyst provides sophisticated diagnostic capabilities to troubleshoot
bottlenecks and performance inefficiencies that result in poor space management. See the
DBArtisan online help for a detailed walkthrough of all available features and functionality.

2 Select the Data Files, Tablespace Map, Tables, and Indexes tabs available at the bottom of
the Space Analyst pane.

3 Close the Space Analyst pane.
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SESSION 5: SOL MANAGEMENT

DBArtisan provides powerful visual tools for creating and analyzing complex SQL statements
and server-side code objects. The following examples walk you through DBArtisan’s Visual
Query Builder, feature-rich ISQL facility and some of the advanced analysis and debugging
capabilities provided by the Embarcadero SQL Debugger and SQL Profiler.

VISUAL QUERY BUILDER
1 From the Tools menu, select Query Builder.

DBArtisan opens the Query Builder.
2 In the Tables/Views tab, right-click a table or view and select Add.

3 Inthe window that opens, select the columns to return in the result. For example:

Alx]
_"ROWID"

_IWVENDOF,_LOAD 1D
ASERVICE MM

AORIGIN CD
_IDESTIMATION CD
_ILOCKOUT _TIME
JAVAILABLE TIME

_IMOMNDAY TEANSIT DAYS
ITUESDAY TRAMSIT DATS
_IWENDESDAY TRANSIT DAYS
_ITHURSDAY TREANSIT DAYS
_IFRIDAY TRAMNSIT DAYS
JSATURDAY TRAMNSIT DAYS
_ISUNDAY TRAMSIT DAYS

Query Builder generates the query text in the lower SQL window.

SELECT SYSTEM.ANH. SERVICE NM,
SYSTEM. ANH. ORIGIN CD
FREOM S¥Y3TEM.ANH

{1 [T N PN R

You can build advanced queries using the options supplied on the DML tab. You choose the
type of query (SELECT, INSERT, and so on) using the dropdown on the Query Builder
toolbar.

4 After the query is built, click the Execute button (green arrow) on the Query Builder toolbar.
Query Builder displays results in the lower SQL window.

5 Close the Query Builder pane.
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ISQL WINDOW

DBArtisan offers a fully-featured SQL editor. In addition to basic text processing features, the
editor environment offers testing/debugging and execution facilities. In combination with
supporting features, the ISQL editor eases and speeds up the process of developing working
scripts.

- P MO IE # h-O % 2RI A
1 SELECT * FROM Jobs

Auto Commit Off | | S ROMLABORCL11 g 2%system | Line 1 Cal19

AUTOMATED ERROR DETECTION AND CODING ASSISTANCE
DBArtisan provides a range of features that detect or help you avoid errors and save keystrokes
in developing your scripts.

To enable these features:
1 On the File menu select Options. The Options dialog opens.

2 Inthe left-hand pane, expand the ISQL node and then select Code Assist.
3 On the Code Assist panel:

e Ensure that Enable Code Complete is selected.
e Ensure that Enable Real-time syntax checking is selected.
® Ensure that Severity levels for semantic validation problems has Warning selected.

4 Click OK.

To see these features in action:
1 On the File menu, select New > ISQL.

DBArtisan opens the ISQL Editor window. You can add SQL code via your method of choice
(free-form typing, retrieve from a file, paste copied code, etc.).

2 Experiment with the automated error detection and coding assistance as follows:

e Type SELECT * FROM and stop typing. Note the error condition.
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1® SELECT * ERQM

By default, DBArtisan runs a syntax check any time there is an interval of 1.5 seconds
between keystrokes. You can also disable automatic syntax checking and only run a check
when you manually initiate it. Syntax error annotation persists until you correct the problem.

e This time type a fragment that includes the name of a nonexistent object, SELECT *
FROM NON.OBJECT, for example. For now, ignore any popups. The warning condition is
a result of on-the-fly semantic validation. DBArtisan notifies you when a script contains a
reference to an object that DBArtisan cannot resolve.

® Type SELECT * FROM followed by a space and then stop typing. If no popup appears,
press CTRL+SPACE. The Code Complete suggestion box lets you select from objects or
object name components such as databases or schema. This feature saves keystrokes and
minimizes typing errors. See the online help for full descriptions of these features.

If you want to disable the automated error detection and coding assistance features, select
File > Options and on the Code Assist page, click Restore defaults.

FEATURE SUMMARY
The ISQL Editor window includes the following features and options:

e The ISQL window highlights all platform-specific and general keywords, and provides
options for SQL code formatting and analysis.

e Once code is executed you have control over whether your transaction is committed or
rolled back from the database.

e For all open ISQL windows, there are also options for connection locking, scheduling,
executing your code across multiple datasources, explain plan generation, and SQL Tuning.

SETTING ENVIRONMENT OPTIONS

DBArtisan lets you set platform-specific query options to immediately determine if your code is
optimized.

1

36

Press F8.

DBArtisan opens the Query Option dialog.
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Optian Value
= Query Analysis
Metwaork Activity
Execution Information
170 Activity
Sort Activity
Indesc Activity
Parse Activity
Table Activity
05 Activity
Wait Activity
= Miscellaneous
Batch Delimiter o
Row Count 0
LONG Size {bytes) 2152
Mz Errors Before Aborting (0 = off) 0
Check syntax when executing [}
Run script with batch execution

OoooooEo=

2 Either close the Query Options dialog and then the SQL Editor window or enter a valid
query in the ISQL editor and then execute your query by clicking the Execute button.

b

3 When complete, ensure that only the Datasource Explorer window is open.

SQL DEBUGGING, ANALYSIS AND TUNING

To analyze and debug your SQL code, DBArtisan provides cross-platform SQL code debuggers,
and for your Oracle databases, a robust PL/SQL code profiler that helps you to pinpoint and
eliminate “hot spots” within poorly running server-side code. To ensure code efficiency, the ISQL
window provides tight integration with Embarcadero’s SQL Tuner, so you can perform multiple
“test then tune” iterations without having to leave an open ISQL window.

While this example is specific to Oracle PL/SQL Debugging, the same interface and functionality
applies to all of the supported platforms.

To see debugging in action

1 On the Datasource Explorer, expand any Oracle datasource node.
2 On the Oracle datasource, select the Procedures node.
3 Inthe right pane of the Explorer, right-click any stored procedure, and then select Debug.

4 If prompted, enter any input parameters and then click Continue.
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After the SQL Debugger interface is displayed you can step through code, step into
dependencies, set and watch variables, and even perform basic code profiling for each line of
executed code. See the DBArtisan online help for a detailed listing of all available SQL features.

5 Experiment with debugging features and then close the debugger window.

SESSION 6: JOB MANAGEMENT

DBArtisan freely integrates with the Microsoft Windows Task Scheduler, which allows you to
virtually schedule any task to run on your own computer whenever and how often you'd like.
While this example is specific to an Oracle table redefinition, the same concept applies to any
job or script that can be scheduled.

To schedule a job, do the following:

1 On the Explorer, expand any Oracle datasource.

2 Onthe Oracle datasource, expand the Tables node, right-click any table, and select Extract.
DBArtisan extracts the DDL that defines the selected table and opens an ISQL Editor
window on the DDL.

3 From the ISOL window toolbar, click the Schedule button.

@

The Schedule Action dialog opens. You can provide a name, set notifications, and specify
an output directory for the new job.

Schedule Action Dialog

Specify Information for Motification of Job Completion

Job Hame:
|SOLS chedulerD8] 20071127200

Jaob Description [Email subject line]:
[SCILS cheduler

E b ail Addrezz(es] [Separated by semi-colons]

Met Send: [Metwork user names separated by semi-colonsz)

Action Output Directany;
CADOCUME ~1hdavidtLOCALS ™14 Tempt =

v 0K | [;&i gam:el] ["? Help ]
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4 After you have completed the dialog, click OK. The Job Scheduler dialog opens.

5 Proceed as prompted to schedule your job. When finished, close the ISQL window.

You can use the Oracle Job Queue explorer node to monitor your job.

SESSION 7: DATA MANAGEMENT

DBArtisan provides comprehensive facilities to help you manage the data in all of your
databases. A visual data editor helps you add, change, and delete data from your tables with all
referential integrity enforced. You can create INSERT statements for tables using current data
and also extract data as XML documents for certain databases. Rounding out its rich Schema
Management capabilities, DBArtisan also allows you to migrate schema objects and associated
table data from one database server to another, across the same or different platforms.

VISUAL DATA EDITING

To start the Visual Data Editor, do the following:

1 In the Datasource Explorer, right-click any table and select Edit Data. DBArtisan opens the

Data Editor Filter dialog.

2 In Columns, select the columns that are to be included in the editable data.

.

[Drata Editor Filter

X

Congtruct a Select Statement to filker data for the Data Editar
Colurnns:

] RO ID"

(]

|[v]e _ Clear &l

Where:

Select Staterment;
SELECT T."ROWID", T.&, T.B, T.C FROM &, 8RTZ T

0K || # Cancel || 2 Help

You can also filter the editable rows by including your own SELECT statement.
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3

Click OK.

In Live mode all changes are applied to the database when you move off of an updated or
inserted row. Deleted rows are immediately removed from the database. Batch mode allows

you to make changes and then save all when all are complete. Mode is controlled by a
dropdown in the Data Editor toolbar.

Experiment with editing your data, and when complete, on the Data Editor toolbar, click the
Execute (blue arrow) button.

DBArtisan commits your changes. Regardless of mode, all of the generated DML
statements are viewable in the lower SQL window.

14

1 F M 501 Y History
ik —-— Btatements To Be Executed: L]
=] —— ==========————=————=————————————————————————=—=—===
3 UPDATE A.ARTZ BSET ARTZ.B="t" WHERE ARTZ."ROWID"=
TAABeTdAABAACOECAAD™ AND ARTZ.A="s " AND ARTA.B=
" * END ARTE. ="k :
4 COMMIT a
5 [

Fow 5 Col 3 5 Rowis)

5

Close the Data Editor pane.

WORKING WITH TABLE DATA — CREATE INSERT STATEMENTS
DBArtisan lets you generate a set of INSERT statements based on rows of an existing table.

1
2

40

On the Datasource Explorer, select any Oracle datasource.

On the Oracle datasource, expand the Tables node.

In the right pane of the Explorer window, right-click any table, and then select Create Insert
Statements. DBArtisan opens the Create Insert Statements dialog. For example:
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- =

Create Insert Statements

Construct a Select Statement to filker data

Colurnrs:
Lz
I
[[e
|

"-:i-"here:

| add Al

Select Staterment;

[+]Include owner or schema information in Insert statements

[]5et row count

_v"" i}, | % Cancel || FJ Help

4 In Columns, select the columns you want to include in the INSERT statement.
5 You can also filter what rows are included by adding your own WHERE clause.

6 Click OK.

The resulting INSERT statements are created and presented in an active ISQL window. At this
point they can be executed immediately, scheduled to execute later, or saved. Note that all
extracted INSERT statements can be run against the same or different databases containing a
similar schema.
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——- TABLE IMNZSERT STATEMENTS

INSERT INTC HE.JOB HISTORY ( JCOB HISTORY.EMPLOYEE ID,
JOBE_HISTORY. 3TART DATE, JOB_HISTORY.END DATE,

JOE_HISTORY.JOB_ID, JOE HISTORY.DEPARTMENT ID
VALUER. € 113, To DATETii; D& 2008 EB: 43 24 05",

TMM/DD/YYYY HH1Z:MI:SS AMT),

TO DATE ("01/15/Z007 12:43:24 PMT,

THM/DD/EYYY HHIZ:MILEE AMT}, TRO MAMY,. 270 )
/
INSERT INTO HE.JOBE HISTORY ( JOB HISTORY.EMPLOYEE ID,
JOB_HISTORY.START DATE, JOB HISTORY.END DATE,
JOB_HISTORY.JOE ID, JOB HISTORY.DEPARTMENT ID )

VALUES ( 102, TO DATE ('01/13/1993 12:00:00 AM',
THM/DD/ YYYY BHIZ:MIVE8 AMT),
TO DATE ("07/24/1998 1Z2:00:00 AmMT,

"MM/DD/YYYY HH12:MI:SS AM'), 'IT PROG', 60 )
;

7 Close the editor pane.

WORKING WITH TABLE DATA — EXTRACT DATA AS XML
DBArtisan lets you generate an XML representation of table data.

To extract data as XML

1 On the Datasource Explorer, expand any Oracle datasource.
2 On the Oracle datasource, expand the Tables node.

3 Inthe right pane of the Explorer window, right-click any table listed, and then select Extract
Data as XML.

4 Select the columns to include in the SELECT statement.

5 You can also filter what rows are included by adding a WHERE clause in the Select
Statement box.

6 Click OK.

The resulting XML document is created and presented in an active XML Editor. At this point
the document can be saved in XML format.
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f:j j:ﬂ Cloze

1 <?uml version="1.0"7> Ead
2 [<ROWSET> :
2 [ <ROwW>

4 <ROWID=AAAHM/ AAFAAAARSARAA</ ROWID>

5 <EMPLOYEE ID>113</EMPLOYEE IDX

& <8TART DATE>11/04/2006 1Z:43:24 PM</START DATEZ>

7 <END DATE>01/15/2007 1Z:43:24 PM</END DATE>

& <JOB_ID»PU MAN</JOB ID>

9 <DEPARTMENT ID>Z70</DEPARTMENT ID>
10 </ ROW>
11 [ <ROwW>
12 <ROWID=AAAHM/ AAFAAAABUARAA</ ROWID>
13 <EMPLOYEE ID>102</EMPLOYEE IDX
14 <8TART DATE>01/13/19%3 1Z:00:00 AM</START DATE>
5 <END DATE>07/24/1998 1Z:00:00 AM</END DATE>
1a <JOBE _ID>IT PROG</JOB ID>
1 <DEPARTMENT ID>60</DEPARTMENT ID>
18 - </ ROW> e
q T\l.\ﬂ [0 Explareri™, —1 XML Editor: JOB_HISTORY | b

7 Close the editor pane.

ADVANCED DATA MANAGEMENT — SCHEMA AND DATA MIGRATION

DBArtisan provides advanced data management tools that help you to move schema and
corresponding table data across the same or different platforms. You can copy a single database
object, all objects owned by a specific user, or an entire database, all guided by a wizard-driven
process.

While this example is specific to an Oracle to SQL Server schema and data migration, the same
concept applies to any migration involving any combination of the supported platforms.

To open the Schema Migration Wizard:
1 On the Utilities menu, select Schema Migration. DBArtisan opens the Migration Wizard.

2 Select the Perform new migration option.

3 Click Next. DBArtisan opens the next panel of the Migration Wizard. For example:
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o~

Migration Wizard - Step 2 of 7
Connection
Select a zerver and databaze.
Source Datazource Target D atazource
Select a datazource to dizplay Select a datazource to dizplay
[ = any character, * = anp String] [ = any character, * = any String]
| Bl SAMPLE_DATASOURCE (Oracte) &) | ElCAPSAMP (1BM DB2 L) ]
| SCOTTY [Microsoft SOL Server] |l Sl DALLAST [DB2 Z/05) (W
:'-_-";'!]SI:EITTWSDLEXF'HESS (Microsoft SOL = | j'gDﬂ«LLﬁ.SE [DB2 Z/05]
Z:f‘;!lTESTDSLISEH [Microzaft SOL Server] f,:!]D.-’-'-.LL.f-‘-.SS[DE:ZZHDS]
_'-f!|TESTDSI_ISI2I1 MMICROSOFTHHSSEE (b ;_,?.'L]Datu:ubEE [Qracle)
[ E,ETDFEL&.BDBEBLS [IBM DE2 LW ﬁh[ﬁlatnbvmﬂﬂ?tc [IBM DE2 LW
| C TORLABORCL0G_1 (Oracle) i D atoelsie (Oracls)
| Em TORLABORCL10g 2 [Oracle] | =_£-_-'] DATOERICAT [Microsoft SUL Server] [
[ E_:?QTEIHL.&ESW A01_1 [Spbaze ASE) | E@Dﬁ-\TDTEE'I [Microzaft SOL Server) [l
£ | (2] =] E
T T m——

4 Select an Oracle datasource from the Source Datasource list and a Microsoft SQOL Server
datasource from the Target Datasource list.

5 Click Next and provide login credentials if prompted. DBArtisan opens the next panel of the
Migration Wizard.

Since Microsoft SQL Server supports multiple databases per datasource, you must choose a
database.

6 Select an entry from the Target Database list and then click Next. DBArtisan opens the next
panel of the Migration Wizard.
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-~

.Migratiun Wizard - Step 4 of 7

Object Selection
For each object bupe, select the objects that vou wizh to migrate.

Object Topes COhjects

| []+}* Check Constraints (] '
[t Clusters
[14% Configuration Parameters
[ %y Database Links

(g Directories

[ ]%% Fareign keys

[ Groups

[1El Indexes

[1[E5] Jobs |
[ Libraries R

[ Select Al ”Llnselect.-’-'-.ll]

[ < Back ” Fext = l [ Finizh ][ Cancel ] [ Help ]

7 In the Object Types list, select the object types to be migrated to the target datasource.

As you select object types, the Objects list is updated to let you select specific objects to
migrate. The Expand/Collapse icons let you drill down through dependencies/
containment.

8 Use the Objects list to select the specific objects to migrate.

9 Click Next. DBArtisan opens the next panel of the Migration Wizard.
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Migration Wizard - Step 5 of 7

Options

8|24

=l Secript Options

Script f Mot Exists

File Encoding

{f| = Owner Options
Script Owner
Owner

Change Owner To
Copy Chwner

Choose your migration options.

= Dependency Options
Group Dependencies
COrder Drops By Selection

Script Drop Statements
Script Create Statements
{ Script Object Privileges
Script System Privileges

Script Use Statement

=1 Rl et imes T

bExample Preview

- USE adinuta E
L
O CREATE TABLE dbo.ExamplePre

(
1 order_id  int NOT NULL, i
A customer_id int NOT MNULL, 3
0 3 term_id int NOT MULL,
[ COMNSTRAINT EXAMPLE_PK
PRIMARY KEY (order_id)
) T
ANSI ™ ON FileGroup2B
go
IF OBJECT_ID({N'dbo.ExamplePr&
Retain Owner [ | | PRINT N'<<< CREATED TABI ~
] 1l | ;

]

¥ - Save Options Template

| - | Save Delete
[]5et as Defauit
< Back Nesdt = Finish Cancel Help

RS

10 Examine the migration options offered but leave the default settings for now.

11 Click Next. DBArtisan opens the next panel of the Migration Wizard.

Clicking Finish executes the migration and lets you view the progress of the job.

SESSION 8: PERFORMANCE MANAGEMENT

DBArtisan offers a number of different options to help you manage the performance of your
databases. First, DBArtisan ships with a built-in process monitor that helps you understand who
is connected to your database along with each user’s current activity and session-related data.
For more robust performance details DBArtisan’s Performance Analyst add-on is a powerful
client-side database monitor that runs fully contained in the DBArtisan console.

46
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MONITORING SESSIONS

While this example is specific to Oracle the Process Monitor is available for all of the supported
platforms.

To start the DBArtisan Process Monitor:

1

On the Datasource Explorer, select any Oracle datasource.

2 From the Utilities menu, select Database Monitor.

5ID | 5tatus|0.5. |Serial # Type DB User |Client Us Logon Time Sery

iy E— )

The Database Monitor includes the following options and features:

¢ Highlight any session and any currently running SQL is displayed in the lower pane.

e You can drill-down into a specific session to display session-level statistical details,
historical and current wait events along with a working copy of the currently running SQL
that can be copied to an ISQL for Explain Plan generation.

¢ By using the Monitor dropdown options you can display more advanced database-level
monitoring data such as locks, blocking locks, hit ratio by user, Top 20 SQL etc.
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f:;! Monitor: | Processes

i)

Processes

1Ak

&l Locks

Drakafile If0

Latches

534 Detai

Wait Events

Blacking Locks

Active Rollback Segrents
Drata Dictionary Cache

General Statiskics
Hit R.atio By User

Library Cache

MT3 Dispatcher Contention
MTS Server Contention
QOpen Cursors

Parallel Queries

Sh Hik Ratios

2GA Summary

54 Drwnamic Components
Tablespace 10

Top Twenty S0L

3 Close the Database Monitor pane.

48
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ADVANCED CLIENT-SIDE PERFORMANCE MONITORING

For advanced performance monitoring and management, DBArtisan’s optional Performance
Analyst provides intelligent diagnostic information and strong drilldown details to help you get
to the heart of any episode of performance degradation. Performance Analyst integrates
completely with DBArtisan, so you can fix any performance problems with a few clicks of the
mouse.

NOTE: Performance Analyst is available for Oracle, SQL Server, Sybase ASE and DB2 for Unix,
Windows, and Linux.

NOTE: Performance Analyst is a separately-licensed component. If you are not working with
an evaluation copy of DBArtisan or do not have a specific license, proceed to Session
10: General Utilities and Tools. Contact your license administrator or your
Embarcadero representative about obtaining a license.

1 On the Datasource Explorer, select any Oracle datasource.

2 On the Analyst menu, select Performance Analyst. The Performance Analyst opens in the
DBArtisan workspace for the target datasource.

In addition to the Home page displayed initially, Performance Analyst presents several
pages of statistics. Page categories include Memory, I/0, Space, Objects, Users, and OS.
Each page contains several panes of related statistics, the Home page’s Key Ratio Analysis
pane, for example:

.{ﬁ. Key Ratio Analysis D-Elﬁ

Efficiency Activity
& Buffer Cache Hit Ratio & Buffer Busy Wait Ratio 0.00 %
& Library Cache Hit Ratio 100.00 % & Rollback Contertion Ratio 000 %
& Dictionary Cache Hit Ratio  100.00 % & Latch Mizz Ratio 0.00 %
& Memary ot Ratio 100.00 % A& Parallel Guery Busy Ratio 000 %
Parze/Execute Ratio 100.00 % Free Shared Pool Percent  23.27 %
100 % e —
95 % - oy PN R
a0 % 13: ipiseemiseatlToomis
85 % 5%' toinscnisen Heaopie
a0 % .
0 %

- . ¥ T ¥ o ¥ Y
19:30:00 19:55:00 19:50:00 19:55:00

Note the toolbar at the top of the Performance Analyst. It lets you navigate among the
Performance Analyst statistics pages.

[rﬁHnme B Memory ~ [EI/O - E';Space 'ﬁﬂbiects - BLlsers - [BEos -~

3 Experiment with displaying the various pages available from the toolbar dropdowns.

See the DBArtisan online help Performance Analyst topics for a detailed walkthrough of all
available features and functionality.
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For enterprise performance monitoring, DBArtisan integrates with the Embarcadero
Performance Center Web Client. While integration requires a licensed Performance Center
server, there are no upgrade requirements for the DBArtisan console.

NOTE: You should only work through the following exercise if you are a current Performance
Center user. If you are not a Performance Center customer, please read the following
for information purposes only.

Use the following to establish a quick connection to your Performance Center server:

1 On the File menu select Options.
2 On the Options Editor, select the Perf Center tab.

3 Select the Web Client radio button and enter the Performance Center server info as
indicated.

4 Perform a test to ensure the configuration is correct.

5 After a connection is established you can use the Tools > Performance Center option to
launch the Web Client within the DBArtisan console. If you are using the full Performance
Center client you can use this same Options editor tab to switch back.

fi

o

| eniee Cown  ow  Rresss Dhuge B s s §3seen Rl oo

e - —_—

=[S == ]
—— o Clirersn Mo @ R o

([t Bemm Tpw
T AT

X BT TR YT
433 3004 LantnsnIm Atk Suky 33, 3684 134534
CoNTINTION WTd o e 0 wiTad s o
97.25 % ocked Users o * Total Server Reads o data
* P Plan it Rati so00 " mumbserof Deadocks o datafh Tatall Sercer Wirtes o data
* Adboc 0L W Ratio 51 Lok Tmeosts o data§ Log Plushes. o datas
* Log Cache bkt Ratio o0 ® Latch Waits o data % L0 Lrrors o data

bR RAEEEES
'__.
I

SR WAL oy N BPACE WAL o Y TR WAL BeN e

Total Connestions " Databises Low On Space 1 Packets Hecehed o data.
Adthve Contections 1 Logs Liw 0N Spin o Pichets Soent o data
Transactions o Lispens. o data
Cwrent Locks 1 Logoats. o data
l
P R e | L e
FTET] -e 04000 2um

NOTE: The Performance Center web client provides read-only access to the monitored
datasources. To perform edits or maintenance, you must switch to the full Performance
Center client.

Please see the relevant DBArtisan online help topics for a detailed walkthrough of all available
features and functionality.
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SESSION 9: CAPACITY MANAGEMENT

Planning for the future of your critical databases used to be a difficult task. However, DBArtisan’s
optional Capacity Analyst tool makes it easy to understand where your databases are today and
where they are headed in the future. Capacity Analyst lets you track key database metadata and
performance metrics over time so you can perform trend analysis on key areas like growth,
object fragmentation, I/0 and session load. Like all of the Analyst Series products, Capacity
Analyst runs fully contained within DBArtisan so you have access to smart, built-in forecasting
mechanisms that allow you to predict when your databases run out of space and the ability to
proactively manage your storage assets, all from the same console.

Performance Analyst is available for DB2 for Unix, Windows, and Linux, Sybase ASE, Oracle, and
SQL Server.

1 On the Datasource Explorer, select any Oracle datasource.
2 From the Analyst menu select Capacity Analyst.

NOTE: Capacity Analyst is a separately-licensed component. If you are not working with an
evaluation copy of DBArtisan or do not have a specific license, proceed to Session 10:

General Utilities and Tools. Contact your license administrator or your Embarcadero
representative about obtaining a license.

The Capacity Analyst opens in the DBArtisan workspace for the target Oracle datasource.

|8 Ebarcicdars Bt 8168 - Copacity Anbed - [IGAAVOLASY] Lok
| B o temmsn e ol s Dk pwr Qe e beesin gees S ]

- m
e N T

| = Jlldidl. BN eRHE .
et A5F I g ODEADsw 1. REISRERE. "0 TITaoabiR.

1 : [ o % Ta L « b meSe X D,

Me-aa4+no M

it et Se i [ O
S

LR R TS | FEFE T o T | ETTE T

TR L e Bk

| || e sesius - [T |t Bt - (L LI || e et [EET = rmre na| || et s (EETEE | s oo

£
| =

See the relevant DBArtisan online help topics for a detailed walkthrough of all available features
and functionality.
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SESSION 10: GENERAL UTILITIES AND TOOLS

No evaluation of DBArtisan would be complete without a mention of the general utilities and
tools that are available across all of the supported platforms. The Utilities menu offers primarily
DBMS-specific operations while those offered on the Tools menu are more generic.

utiliE : L:-c[%:
3 Michema Extraction,.. | B Find in Files. .

ﬂ.j Schema Migration, .. :ﬂﬂ, Database Search...
&l schema Publication, ., | @ Scripk Execution Facility
Bifl Diata Unload. .. [ ETB» File Execution Facility
EI:‘I Data Load.,. [ @ Scheduler
| 8 Visual Diff...
Bl Database Monitor [ s
B; Dakabase Export... [ E| Cery Builder
ﬂg | Database Impart, .. SCL Brofiler E

[ @ Table/Index Size Estimator

Archive Ackivity, .. | e
| Imnpork Daka
Backup Control File, .. g =P

: : DBZ 2/05 Server Component Inskallation L
Chained Row Analvsis, .

Free Space Deficit, .. ODBC adminiskrator

dﬁ’l- Instance Configuration, .. Parfirmance Canber

Mazirnurn Extent Limits. ..

Finned Code. ..

Resource Cost,,. Code Warkbench

=
\d

& SOL*Plus
»

P

Session Information., .. Cuskomize. ..

Top Sessions. ..

The Utilities menu contains the more advanced DBArtisan features. The available menu items
are context-sensitive and version-specific for the selected datasource DBMS platform. This
example above shows the Utilities menu features that are available for Oracle.

The Tools menu contains those features that are common across all DBMS platforms. The
example above shows the Tools menu features that are available for all supported DBMS
platforms. Note that if any other Embarcadero products are installed on your client they will be
available on the Tools menu.

All DBArtisan utilities and tools provide a common interface that walks you through all input and
execution requirements. All results are consistently presented so you can easily move between
features without effort or confusion.
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